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CHAPTER 11 INTERACTIVE FIELDS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Interactive fields prompt the user to enter specific types of 
information into a document. Interactive fields are useful for 
standard business documents, where only certain information 
changes (such as the author or recipient name). You can set up 
interactive fields to run when calculated, or you can automate field 
activation so that prompts will run automatically when the document 
is opened, for example. 

In this session you will: 

 gain an understanding of interactive fields 

 learn how to insert and use a FILLIN field 

 learn how to type field codes 

 learn how to activate fields 

 learn how to use ASK 

 learn how to use REF to display bookmarks 

 learn how to activate fields automatically. 

INFOCUS 

WPL_W862 
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UNDERSTANDING INTERACTIVE FIELDS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Interactive fields are fields that prompt the user 
to enter specific types of information which is 
then inserted into the document. They are 
particularly useful in business documents, such 

as letters and forms, because they can capture the 
right information and then insert it in the right place. 
This page examines how interactive fields capture 
data and then incorporate it into the document. 

Prompting The User For Information 

When a document contains an interactive field, it will prompt the user for specific types of 
information. The prompt text appears in a dialog box as a message asking the users to enter certain 
information. For example, you could use FILLIN fields in the following fax header sheet to prompt 
users to enter the relevant information into the fax header, such as name, date and so on.  

The beauty of using interactive fields is that users do not need to format or change the document in 
any way, all they need to do is to complete the fields when prompted. This obviously ensures that 
formatting and the like is preserved, and also speeds up document production. 

Displaying Prompts 

There are two ways to display the prompts for users to complete. Users can press  when the 

document is opened to run (recalculate) the fields. Pressing  will display the prompt of the first field. 

The user types the required information, clicks on [OK] and then the next prompt is displayed ready 
for user input. 

If you are creating a template, where users create a new document based on that template, 
interactive fields will run automatically when a new document based on that template is opened. The 
advantage of this method is that users do not have to know how to work with and recalculate fields. 
When the document is opened, the prompts will appear automatically for users to complete. 
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INSERTING A FILLIN FIELD 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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 Before starting this exercise you 

MUST open the file W862 
Interactive Fields_1.docx... 

 Click in the empty cell next to To  

You will insert the FILLIN field 
here... 

 Click on Quick Parts  on 

the Insert tab and select Field 
to open the Field dialog box 

 Click on the drop arrow  for 

Categories and select Mail 
Merge 

 Click on Fill-in then click in 
Prompt and type What is the 
recipient’s name? 

 Click on [OK] 

The field will run and you will be 
asked for the recipient’s name… 

 Type Joy Winters then click on 
[OK] 

Her name will be inserted at the 
cursor (field)... 

 Press  +  to display the 

field codes 

Notice that the formatting of the 
field is retained by the 
MERGEFORMAT switch... 

 Press  +  again to hide the 

field codes, then save the 
document 

 

For Your Reference… 

To insert a FILLIN field: 

1. Position the cursor, then click on the Insert 
tab, click on Quick Parts and select Field 

2. Click on Mail merge under Categories, then 
click on Fill-in under Field names 

3. Type a Prompt and click on [OK] 

Handy to Know… 

 Initially, the dialog box created by FILLIN is 
empty. From then on it will display the 
previous value entered. You can specify a 
different default value (the value shown in 
the dialog box) for a FILLIN field using the 
switch \d. You can even force the text box to 

appear empty every time by using \d "". 
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FILLIN is an interactive field that prompts the 
user for specific types of information to insert into 
the document. When the user has typed the 
information and clicks on [OK], the information is 

placed in the same location in the document as the 
FILLIN field. Any formatting that has been applied 
to this location will be automatically applied to the 
text entered. 
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TYPING FIELD CODES INTO A DOCUMENT 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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Continue using the previous 
file with this exercise, or open 
the file W862 Interactive 
Fields_2.docx... 

 Click in the empty cell next to 
Company and press  +  

to create a field 

This is marked by the 
appearance of curly brackets 
in grey shading... 

 Type FILLIN "What is the 
recipient’s company name?" 
\* MERGEFORMAT 

MERGEFORMAT preserves 
the formatting... 

 Press  to move to the empty 

cell next to Phone press  + 

 to create another field 

 Type FILLIN "What is their 
phone number?" \* 
MERGEFORMAT 

 Repeat steps 3 and 4 to insert 
a FILLIN field that asks for the 
recipient’s fax number 

 Press  +  twice to hide 

and then display the codes, 
then save the document 

 

For Your Reference… 

To type field codes into a document: 

1. Position the cursor 

2. Press  +   

3. Type the code 

Handy to Know… 

 For a complete list of fields and their 
corresponding field properties and switches, 
go to www.microsoft.com and search for 

Word Field Reference. 

1 
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Although the Field dialog box can be used to 
paste fields into a document, a proficient operator 
can type working fields directly into a document 
without needing to use the ribbon. This can be 

quite handy once you are comfortable working with 
fields and confident using the correct field code 
syntax. It can certainly save time in developing 
documents that have multiple fields. 
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ACTIVATING INTERACTIVE FIELDS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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Continue using the previous 
file with this exercise, or open 
the file W862 Interactive 
Fields_3.docx... 

 Make sure the field codes are 
hidden, then press  +  to 

select the entire document 

 Press  to recalculate the 

fields in the document 

The first prompt will appear 
with Joy Winters as the default 
text, as this is the last value 
that was entered... 

 Click on [OK] to accept Joy 
Winters  

The next prompt will be 
displayed... 

 Type AGE – London then 
click on [OK] 

The phone number prompt will 
be displayed… 

 Type 0011 44 2641 6666, then 
click on [OK] 

The fax number prompt will be 
displayed… 

 Type 0011 44 2641 7777 and 
click on [OK], then deselect 
the text 

The captured information will 
be inserted into the relevant 
fields 

 

For Your Reference… 

To activate interactive fields: 

1. Either click in a field or press  +  to 

select the entire document 

2. Press  

Handy to Know… 

 If you were to create a template that includes 
FILLIN fields, and users created a new 
document based on that template, the 
prompts would be displayed automatically as 
the document is opened. Users are therefore 
not required to understand how to work with 
fields to use the document. 

1 

2 

Fields are like mini-programs that perform 
actions. To activate the program, you must 
recalculate the field. Fields can be activated 
manually so that you can test them or update the 

field values. You can activate a single field at a 
time or select the entire document and activate all 
of them. When more than one field is updated at a 
time, they are processed sequentially. 
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INSERTING AN ASK FIELD 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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Continue using the previous 
file with this exercise, or open 
the file W862 Interactive 
Fields_4.docx... 

 Click in the empty cell next to 
From 

 Press  +  to create the 

field then type ASK 
"Company" "What is the 
sender’s company?" 

“Company” is the name of the 
bookmark that the value will be 
stored in, and “What is the 
sender’s company?” is the 
prompt... 

 Press  +  twice to display 

and then hide all of the field 
codes 

 Press  to activate the ASK 

field 

The dialog box will be 
displayed... 

 Type AGE - Melbourne then 
click on [OK] 

Nothing appears to have 
happened, but the company 
name has been stored in a 
hidden bookmark… 

 Save the document 

 

For Your Reference… 

To insert an ASK field: 

1. Position the cursor 

2. Press  +  to create the field 

3. Type ASK followed by a “bookmark name” 

and “prompt”  

Handy to Know… 

 ASK is usually used in partnership with the 
field code REF, which inserts the contents of 
a bookmark. ASK prompts the user to enter 
specific data, and REF inserts that data 
anywhere in the document where there is a 
REF field that contains that bookmark name, 

(such as “Company”).   

1 

2 

The FILLIN field prompts for information and then 
inserts it directly into the document. The ASK 
field prompts the user for information, but stores 
the response in a bookmark. The bookmark can 

then be used to insert the information in more than 
one location in the document. This is great for 
company names or course names – anything that 
needs to appear several times. 
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USING REF TO DISPLAY BOOKMARKS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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Continue using the previous 
file with this exercise, or open 
the file W862 Interactive 
Fields_5.docx... 

 Ensure that the insertion point 
is positioned in the empty cell 
next to From 

 Press  to make sure that 

the REF field will be inserted 
after the ASK field 

 Press  +  to create a field 

and type REF "Company" 

 Press  to calculate the field 

The value that was stored in 
the bookmark will be 
displayed. It can also be used 
elsewhere in the document... 

 Double-click at the bottom of 
the page to activate the footer 
and position the cursor, as 
shown 

 Press  +  to create a field 

and type REF "Company" 

 Press  to calculate the field 

The value stored in the 
bookmark is now also 
displayed here… 

 Click on Close  to close the 

header and footer, then save 
the document 

 

For Your Reference… 

To use REF to display bookmarks: 

1. Click where you want the contents of the 
bookmark to appear 

2. Press  +  then type REF "Bookmark 

Name" 

3. Press  to update the value if necessary 

Handy to Know… 

 The advantage of using fields and 
bookmarks is that if a different company 
name is required, it can now be typed only 
once and will appear wherever the REF field 
is used. 

3 
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The ASK field is used to capture input from the 
user. This input is stored in a bookmark which is 
hidden in the document. The contents of the 
bookmark can be displayed using the REF field. 

This means that the contents of a bookmark can be 
displayed in more than one location in the 
document. The ASK field should always appear 
before the REF fields in the document. 
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ACTIVATING FIELDS AUTOMATICALLY 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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 Continue using the previous file with 

this exercise, or open the file W862 
Interactive Fields_6.docx... 

 Click on the File tab, then click on 
Save As to open the Word Save As 
dialog box 

 Type Fax Template in File name, 
click on the drop arrow for Files of 
type and select Word Template 
(*.dotx) 

 Click on [Save] then close the 
template 

You will now open the template as a 
new document… 

 Click on Start > Computer to open 
Windows Explorer, then navigate to 
the course files folder 

 Double-click on Fax Template.dotx to 
create a new document based on the 
template 

The first prompt will be displayed… 

 Type Fiona Jones then click on [OK], 
then complete each prompt with the 
following data: 

Company: AGE - Dubai 

Phone: 0011 971 4 560 9999 

Fax: 0011 971 4 560 8888 

From: AGE - Melbourne 

The new information will be inserted 
into a new document… 

 Close the document without saving 

 

For Your Reference… 

To activate fields automatically: 

1. Click on the File tab, then click on Save As 

2. Type a file name, click on the drop arrow for 
Save as type and select Word Template 
(*.dotx) then click on [OK] 

3. Open Windows Explorer, navigate to and 
double-click on the template  

Handy to Know… 

 If you are going to use interactive fields in 
templates and make them available for other 
users, make sure you have stored the 
templates in the appropriate Templates 
folder on the network. 
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Fields such as ASK, FILLIN and REF are ideal 
for template documents that are used for 
standard business documents such as letters, 
memos, confirmations, reminders, order forms 

and so on. While fields can be activated manually, 
you can save the document as a template. When a 
user creates a document based on that template, 
the fields are activated automatically. 
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